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RJC1000

What
The RJC1000 is a desktop computer tool for creating reactive music and packaging it for 
distribution on iPhone and iPod Touch through the RjDj platform. 

RJC1000 provides an interface to put together musical material, add reactive effects and define 
different states in a composition that can be triggered by the listener.

Basic workflow with RJC1000:

MyScene.rjz

Prepare loops and samples

Combine with reactive effects 
and synths in RJC1000

Export scene

Install and play on device

Share on RjDj.me

It is built to be a cross-platform application that works on Windows, Mac and Linux, but during beta 
testing there is only a Mac version. 

What is RjDj and reactive music?
RjDj is a player for reactive music scenes - tracks where the musical end result is created in real 
time by a combination of pre-recorded material, real time audio synthesis and sensor effects like 
processed live audio sampling or accelerometer control of parts of the music. RjDj is a free 
application available for iPhone and iPod Touch.
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Overview
The RJC1000 is inspired by the Akai MPC series of music production tools, and gives reactive 
composers access to a number of pads that can be assigned to musical components like loops 
and beats, but also to specifically reactive musical elements like reactive synthesizers or 
augmented audio effects.
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toggle
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Pads
Pads hold modules and samples, and a pad or a row of pads can be turned on/off to experiment 
with different soundscapes and how the reactive components fit with other musical elements.

Modules
The RJC1000 comes with a number of modules that can be assigned to the pads out of the box, 
including a number of reactive reality effects and reactive synthesizers from inhouse RjDj scene 
productions. More modules will be added in the future.

Pages
A certain configuration of active pads can be assigned to one of the 4 avaliable pages, for quick 
switching between different states in the music. When a scene is exported from RJC1000, the 
pages go with it and the listener can swipe between the different states. Using the pages, you can 
let users move through the composition and activate their favourite parts of it by swiping to that 
page.
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Basic usage of RJC1000

Drag module to padDrag module to pad

Drag sample to padDrag sample to pad

Drag sample from filesystem to padDrag sample from filesystem to pad

Right-click to select
a pad without activating
Right-click to select
a pad without activating

Change parameters for
module in the selected pad
Change parameters for
module in the selected pad

Set BPM and root noteSet BPM and root note

Click to activateClick to activate

Headphones and microphone
To get the best use of RJC1000, you need a microphone on your computer (built into most laptops) 
and we recommend using headphones. This way youʼll hear whatʼs going on better with reality 
effects, and the experience when composing using the RJC will be similar to the listening 
experience on the iPhone/iPod touch.

Scenes
The RJC1000 can save your composition as a scene that can be played in the RjDj player on the 
iPhone/iPod Touch. The listener can manually trigger states in the music by swiping between the 
pages. 

Scenes are installed in RjDj on an iPhone or iPod Touch by making them avaliable online and then 
clicking a special install link from Safari on the iPhone/iPod Touch that opens RjDj and downloads 
the scene. See the section “Installing scenes in RjDj on the iPhone or iPod Touch” for more 
information on how to do this.
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Expert Mode: Pure Data
RJC1000 is a front end for the Pure Data audio programming environment and signal processing 
engine, and by opening files exported from RJC1000 in Pure Data you have access to a range of 
very powerful configurations, tweaks and detailed control over the scene. See the “Expert Mode: 
Pure Data” section below for more details on how this works.
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Manual
Installing RJC1000

Mac Installation
When you have downloaded the RJC zip file, unzip it and move the RJC1000 application to your 
Applications folder.

Launch the application by double clicking the icon.

Using RJC1000

Using pads and modules
• To assign a module to a pad, drag it from the list of modules to a pad.
• Click the pad to turn the module on.
• Modules have some parameters you can tweak. These will show up on the parameter knobs 

when the pad with the module is selected.
• To see and change the settings for a module on a pad without turning on the module, right click 

on the pad.
• To replace a module, just drag a new one onto the pad.
• To remove a module from a pad, click on the pad to select it, then choose “Clear active pad” from 

the Edit menu.

When dragging a new module to a pad, you will hear a short audio dropout when the module is 
loaded into RJC1000. This is expected, and if you load longer samples, the loading time and 
dropout could be significant. But once modules are loaded, switching them on and off or switching 
between pages should not cause dropouts. 

Setting BPM
Some modules respond to the BPM setting, and some or all of the sound in the module will be 
controlled by it. Read the module description to find out if a module listens to BPM or not. 

Setting a root note
Some module respond to the root note setting, that you can use to define the root note of 
synthesizer modules that play a predefined pattern. See the module description to find out if a 
module responds to the root note setting or not.  

Using pages
Pages make it easy to switch to a certain combination of active modules while making a scene in 
the RJC1000, and also provides the user of the resulting scene a way to switch between those 
different states of your composition. The idea is that you put all of the modules your scene uses 
onto the pads, and then create different states that you can easliy switch between by having 
certain modules on or off in the 4 avaliable pages.

The modules assigned to the pads will stay the same, so one RJC1000 projects can only have 16 
modules active in total. Click one of the page pads, and turn on the modules you want on for that 
page. Switch to another page pad to create another arrangement.

Getting your samples and loops into RJC 1000

1. Prepare your loops in your favorite audio production software. All samples need to be at 
22050 Hz sample rate. (This is the samplerate the RjDj player on the iPhone operates at)

2. Drag and drop your sample onto a pad in RJC1000, either from the samples folder in the 
modules list or from your filesystem. This will automatically add the sample player module to 
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that pad with your sample loaded into it. The sample player module acts as a looper which re-
triggers the sample in sync with the BPM of the RJC1000. Currently the default length of the 
playback cycle is 4 bars. However this can be modified to 1, 2, 4 or 8 bars by using the Bars 
parameter control.

In the future different sample playback modes, for example with additional time-stretching 
functionality, will be made available.

Important: Remember to align the BPM of the RJC1000 to the tempo of your samples.

Note on performance: For scenes to run well in the RjDj player on the iPhone/iPod Touch, there 
are some memory constraints. If your total sample material is bigger than about 12 M, you’ll likely 
be in trouble.

Using reality effects
RJC1000 comes with a number modules that provide realtime effects on audio input. Drag a 
module onto a pad and turn it on to try it. Many modules have parameters like delay time or filter 
cutoff frequency that you can change on the knobs to the right.

The big difference between RJC1000 and other music software with effects is that the effects you 
add will run in realtime for each user of your resulting scene when played on an iPhone/iPod 
Touch.

Note on performance: For scenes to perform well on the phone, there are some limits on how 
many resource intensive effects you can use in a single scene. Your desktop machine is many 
times more powerful than the mobile devices, so what works in the RJC1000 could be full of 
dropouts or not run at all in RjDj. Take it easy and make sure you test on an iPhone or iPod touch!

Using reality synthesizers
Reality synthesizers use sensor data for controlling some part of the sound they make. For 
example, the pitch and filter could be changed by how the device is tilted. Drag one to a pad and 
turn it on, you can tweak parameters on the knobs.

Using regular synthesizer modules
RJC1000 also comes with a few non-reactive synthesizer modules that you can include in your 
scenes. They are examples of the realtime generative capabilities of RjDj, and modules that could 
become reactive in a future release. Drag one to a pad, and tweak the parameters to your liking. 

Saving and opening RJC projects
You can save your work as an RJC1000 project. Choose “Save” from the File menu. The scene will 
be saved as a directory with a .rjc extension. You can open the project again by choosing “Open” 
from the File menu and pointing the file browser to the right .rjc directory. 

Important note: While RJC1000 is in beta, the file format for saving projects might change. We will 
do our best to keep your projects compatible with coming versions, but make no promises.

Scenes in the RjDj player

Installing scenes in the RjDj player on the iPhone or iPod Touch

To play your scenes in RjDj on the iPhone or iPod Touch, you have two options: Installing the 
scenes from your computer over a local wireless network, or upload them to RjDj.me and install 
them from our servers. 
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In both cases, the process is to access a webpage with Mobile Safari on your device, and press a 
rjdj:// link to the scene. This will launch the RjDj player, that will download and install the scene.

MyScene.rjz

Rjdj.me RjzServer on your local machine

RJC1000

Install MyScene.rjzInstall MyScene.rjz

1) Export scene

2) Make it avaliable on the 
network using RjDj.me or RjzServer

3) Open page in Safari

4) Click install link to launch RjDj

5) RjDj launches 
and installs the scene

1) Export. First you need to export your scene. Choose File --> Export Scene. This will export your 
scene for running on a device and package it as an .rjz file so it can be installed by the RjDj 
player from a webpage. Save the file in some convenient place on your computer. Important: 
No spaces in the filename.

2) Install. Choose one of the two installation options described below: Local network installation or 
installation via RjDj.me.
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Local network installation with RjzServer
RjzServer creates a small webpage on your computer that you can reach from your iPhone or iPod 
Touch if itʼs on the same wireless network as your computer.

Download the RjzServer software from http://bit.ly/rjzserver/

Launch RjzServer. It will open a page with instructions in your browser. Choose File --> Set scene 
directory in RjzServer and point it to where you saved your exported rjz file. 

Make sure your computer and device are on the same wireless network, otherwise this wonʼt work!

Installation via RjDj.me
You can also upload the scene to the RjDj.me server and install it from there. 
Go to http://rjdj.me/sharescene and upload your rjz file. You will get a URL for the scene that you 
can launch in Safari on the iPhone/iPod Touch to install the scene.

Note: The upload form at http://rjdj.me/sharescene was initially made primarily for people wanting 
to contribute scenes to RjDj for publication. Donʼt be alarmed by some of the language geared 
towards this in the form, it is perfectly fine to use this upload form for just testing your scene.

You can also use this installation method when you are ready to share your scene with 
others - the URL can be published on your blog or emailed to people, and they will be able to 
install your scene with the same procedure.

Adding your own scene name and artwork
Currently the RJC1000 doesnʼt provide an interface for editing the name, description and artwork 
for your scene, but you can manually edit the files that contains this information. By default, the 
scene will be named the same as the filename of the scene as you exported it from the RJC1000. 

Choose File--> Export Scene and save the scene. This will save a file with the .rjz extension.

1. Change the file extension to .zip
2. Double click the file to unzip it

You should now have a folder with .rj at the end of the foldername. Open this folder in Finder to 
see the contents of the scene.

image.jpg is the static cover art that represents a scene in lists and on the RjDj website. You can 
replace this image with another image in the same format: a 320x320 jpeg image.

screens.png is the pages artwork. You can replace this image with another image in the same 
format: a stitched together png image made up of four 320px screens with some indication to the 
user about which page they are on.

Info.plist can be edited in any text editor, or the OS X Plist Editor application (if you use the Plist 
Editor, you need to make sure that the file is saved in the XML property list format), and these are 
the bits you will want to change:

<dict>
    <key>info</key>
    <dict>
        <key>author</key>
        <string>PUT YOUR NAME HERE!</string>
        <key>description</key>
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        <string>PUT A DESCRIPTION OF YOUR SCENE HERE</string>
        <key>name</key>
        <string>PUT THE NAME OF THE SCENE HERE</string>
        <key>category</key>
        <string>RJC</string> (you can ignore this one)
    </dict>
</dict>

If you want to stay safe, donʼt touch any other files!

Use Rjz-server to install the scene, (it will automatically make it an rjz file for you) or zip the file, 
change the fileextenstion to .rjz and upload it on http://rjdj.me/sharescene.

You can read more about RjDj file formats here:
http://trac.rjdj.me 

Pages in RjDj on the iPhone/iPod Touch

The pages you set up in RJC will be present in the resulting scene when itʼs played in RjDj on the 
iPhone/iPod Touch. The user can swipe between the different pages.

For page switching to work, you need the latest version of RjDj. 

Known issues: 
The swipe detection is a bit crude at the moment, this will be improved in future releases of RjDj. 
Telling the user which page they are on is currently done manually by including little dots in the 
graphic itself. This will also be improved in a future release.

RJC1000 networking features
RJC1000 is also an interface for controlling scenes playing on devices over a local network. If you 
change things in RJC1000 while playing the same scene on the device, RJC1000 will send signals 
to the RjDj player over the network and change the same things in the scene playing in RjDj. This 
feature is in a state of flux, but do play around and remember that if youʼre testing a scene and 
playing around with things in RJC1000 at the same time, this could be the reason for strange 
behaviour.
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Advanced

Expert Mode: Pure Data
You can edit a scene exported from RJC1000 with Pure Data and have full control over whatʼs 
going on. Read more about how to install PD in the correct way for work on RjDj projects at the 
RjDj wiki: http://trac.rjdj.me 

In future releases, RJC1000 will have options to expose more details of the underlying Pure Data 
patches. 

Create your own modules

You can create your own modules for RJC1000. Modules are Pure Data patches that conform to 
the RJC1000 module standard. You can find more information on how to create modules and 
download example patches and documentation at http://trac.rjdj.me/wiki/RJC1000-modules

Troubleshooting/FAQ
Loading the webpage RjzServer tells me to load doesnʼt work on the phone/ipod!

Is your device on the same network as your computer? Double check, because otherwise you 
wonʼt be able to reach the webpage that RjzServer created.

What is the difference between rjz-files, .rj directories and .rjc directories?

An .rjc directory is a saved project from RJC1000. It contains the state of your pads, modules and 
pages so you can continue your work where you left off.

A .rj directory is a directory with the neccessary files for a scene to run on the iPhone/iPod touch. 
RJC1000 can export your work to a scene.

A .rjz file is a .rj scene directory that has been zipped. This is how scenes are installed onto the 
phone and transported over the internet.

My scene doesnʼt make any sound on the iPhone, whatʼs wrong?

Make sure you have some modules turned on in RJC before you export the scene.
Make sure volume is up on both RJC1000 and the phone.
Make sure the page you are on actually had an active module in it. 
Performance issues: If you have a large amount of sample data or a too many resource intensive 
effects, the RjDj player might crash or get so much dropouts that you canʼt hear anything.

Known issues

If you use headphones and plug them out, audio output will stop working. This is an issue 
with Pure Data and audio drivers, and unfortunately the only thing you can do is save your work 
and relaunch RJC1000.
 
If you delete a module from its pad, the description and parameters are still visible until you 
select a new pad. 
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If you change a parameter very fast for a longer time, the message stack clogs up and you get 
audio dropouts. Wait for things to clear up, or save your work and relaunch RJC1000.
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